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About This Guide

This PDF version of the operation guide is provided so that
you can print it in part or in full.
HCopyrights

The contents of this guide may not be reproduced, in
whole or in part, without the prior consent of the copyright
holder.

The contents of this guide are subject to change without
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Introduction

QIS2

This operation guide explains how to use Quick Immunity Sequencer 2 (QIS2) to perform immunity
tests on electrical and electronic devices that are connected to low frequency power distribution
systems and on electrical and electronic devices that have a DC input power port.

HProduct versions that this guide covers

This guide applies to Quick Immunity Sequencer 2 with version 3.x. To view the version, on the Help
menu, click About Quick Immunity Sequencer 2.

EWho should read this guide?

This operation guide is intended for users who will use the PCR-LE Series or PCR-LE2 Series AC
Power Supply to perform immunity tests on electrical and electronic devices that are connected to
low frequency power distribution systems and on electrical and electronic devices that have a DC
input power port. The guide is also intended for instructors who will teach these users.

This guide assumes that the users have knowledge of immunity tests that are performed on electri-
cal and electronic devices.

ENotations used in this guide

+ In this guide, Quick Immunity Sequencer 2 is also called “QIS2,” the PCR-LE Series and PCR-LE2
Series AC Power Supply is also called “PCR-LE,” and the ITO1-PCR-L Immunity Tester is also
called “ITO1-PCR-L"

« The term “PC" is used to refer generally to both personal computers and workstations.
« The following markings are used in the explanations in the text.

Indicates a potentially hazardous situation which, if ignored, may result in
/N\CAUTION

damage to the product and other property.

NOTE Indicates information that you should know.



About Quick Immunity Sequencer 2

QIS2 is application software that uses the PCR-LE Series or PCR-LE2 Series AC Power Supply to per-
form tests.

This software can simulate various phenomena that occur in AC power supply environments. It can
be used to perform immunity tests with conditions that match the following standards on electrical
and electronic devices that are connected to low voltage power distribution systems and on electri-
cal and electronic devices that have a DC input power port. You can set test conditions that exceed
the ranges defined in the standards, so this software can be used to perform preliminary tests
before the tests for the standards, immunity allowance tests, and stress tests.

« |[EC61000-4-11(2004-03)Edition2.0 Voltage dips, short interruptions, and voltage variations
Corrigendum(2010-08)

« |IEC61000-4-13(2009-07)Edition1.1 Harmonics and interharmonics
» |[EC61000-4-14(2009-08)Edition1.2 Voltage fluctuation

- |[EC61000-4-17(2009-01)Edition1.2 Ripple on d.c. input power port
» |[EC61000-4-27(2009-04)Edition1.1 Unbalance

« |[EC61000-4-28(2009-04)Edition1.2 Variation of power frequency

(

« |[EC61000-4-29(2000-08)1st.Edition  Voltage dips, short interruptions, and voltage variations
on d.c. input power port

» |[EC61000-4-34(2009-11)Edition1.1 Voltage dips, short interruptions, and voltage variations
The publication year and date and edition will be omitted from standard numbers hereafter.
The devices that these standards—excluding the IEC61000-4-29 and IEC61000-4-34 standards—

apply to are those that have a rated current of 16 A or less per phase. QIS2 does not take this condi-
tion into account, so you must consider it when you use the software.

®ltems that do not comply with the requirements of the standards

In QIS2, for test configurations that include hardware, there are items that do not comply with the
requirements of the standards. For details, see the items of the appropriate specification.

/\CAUTION

- Because QIS2 uses waveform banks (0 to 63), the waveform data stored in the waveform

banks will be overwritten.! In three-phase operation, the waveform data same as the U-
phase are also written in the waveform bank of the V-phase and the W-phase. If you have
already used the waveform banks on the PCR-LE by itself and have stored important data in
the waveform banks, we recommend that you use the Wave Bank Memory application soft-
ware to save the waveform data to a separate location such as a PC's hard disk.

1 Output waveform data is stored in the PCR-LE internal memory. The memory area for stor-
ing the data of one waveform is referred to as a waveform bank. The PCR-LE has 64 wave-
form banks (0 to 63). QIS2 uses all the waveform banks (0 to 63).

Sine wave data that is used as the PCR-LE’s reference voltage waveform is stored in wave-
form bank 0. In the factory default settings, all waveform banks have the same waveform
(sine wave) as the one that is stored in waveform bank 0.

Depending on the test conditions, QIS2 may overwrite the data in waveform bank 0 with
data thatis not a sine wave. This is not a problem while the PCR-LE is being used from QIS2.
If you want to use the PCR-LE in a standalone manner immediately after you finish testing,
turn the PCR-LE's POWER switch off and on to return the data in waveform bank 0 to the
sine wave data.
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About Quick Immunity Sequencer 2

Performance levels in immunity tests

In immunity tests, the test signal is generated from a voltage generator and is applied to the EUT.
The test result is determined by the operation of the EUT in this situation. The operation is classified
into the following four performance levels according to the EUT’s loss of functionality or decrease in
performance level. The reference for this classification is the standardized performance level that
has been determined by the device’s manufacturer, the individual or organization that requested
the tests, or between the device’s manufacturer and the purchaser.

«  Normal performance that is within the limits of the specifications that have been standardized
by the manufacturer, the individual or organization that requested the tests, or the purchaser

«  Temporary loss of functionality or decrease in performance that returns to normal without user
intervention after the cause of the disturbance is removed

- Temporary loss of functionality or decrease in performance that requires the user to intervene
and make modifications

+ Loss of functionality, decrease in performance, or loss of data that cannot be recovered from
due to hardware or software damage

QIS2



Parts of the Screen

The QIS2 window is divided into the following five panes.

Standard selection Test conditions setup Status display
ot ‘Unt‘led.xml - Quick Immunity Sequencer 2 Elﬁu
File Igdit Instruments Option Help
] =] ©° ] @ 5 & =] Y
© Open| Save Cond. Run Stop Output | Range | Zoomiry Zoom out | Abort

OUTMODE(|| RANGE QUTPUT PHASE
ﬂijH e Low | OFF || =E ||| | ,
V] seq1 Bl Seal Ml Seqp |l Seq3| Seq4[Ml Seqs[ Seqe |l Seq7 [MM Seq [*

Seq 2 .
Seq 3 @ Voltage dips = Dips
61000-4-13 zqu © Short interruption " 0.5 ~ cycle | interval
eq © Voltage variation " 10.0ms T
Seq6 — 10.00 v s L
Phase Select
Seq7  All Seq ~
61000-4-14 Seq 8 () Phase voltage )
Check @ Line voltage UT (Phase) Level (Line)
ERVVYS Seq9 B
Seq10  [Unchedk -ub 100.0 v Vrms | 70.0 v %

-Uc .
61000-4-17 Seq End 173.2 Vrms (Line)
61000-4-1 qompm - © Uc-ua | Copy >
a
Repeat 3 - |

b
61000-4-27 Freq [Hz] 50.00 - gr \a |
o] Wait phase-angle Change angle
Repeat all 3 - 0 v deg
61000-4-]

61000-4-29
61000-4-34
Repeat - Phase Level | Angle |Decreasing| Reduced |Increasing| Interval
No. | ™75y~ |Sea | Testite select | YT | o] |[deq] | [s] (cy:cyde) s] [s]
Waveform preview Result list

NOTE « The QIS2 window is designed to be displayed correctly when the display’s text size is set to the
Windows default value. If the text size is set to a larger value, the text in the window may not fit
properly. For details, see “Display Text Size”
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Parts of the Screen

Pane Description

Standard selection There are eight immunity test standards.
- IEC61000-4-11
- IEC61000-4-13
- |[EC61000-4-14
- |IEC61000-4-17
- |IEC61000-4-27
+ |EC61000-4-28
- |IEC61000-4-29
- IEC61000-4-34

Test conditions setup Set the test conditions that correspond to the selected standard.
You can use the waveform diagram to easily set the settings.

Status display There are PCR-LE status indicators and a progress bar, which dis-
plays the execution progress.

Waveform preview - This displays the waveform that is created from the test condi-
tions that you set. This provides you with a general idea of the
output waveform without having to view it on an oscilloscope.
There are no scales. The waveform displayed here differs slightly
from the waveform that is actually generated.

+ Due to the way the preview is drawn, one cycle of a sine wave is
inserted in the beginning. The actual output is a continuous sine
wave, so it is not necessary one cycle.

« If you switch to a different Seq tab, the waveform that corre-
sponds to that tab will be drawn on the graph. The optimum
scale is calculated each time that you switch to a different tab, so
the vertical scale may be different each time that you switch to a
different Seq tab.

+ Only in three-phase operation, check boxes for showing and hid-
ing the waveform of each phase appear in the left edge of the
waveform preview.

If on the Option menu, you click Display Options and select the Dis-
play Wave Progress check box under Wave Preview Pane Option,
the display will appear in the following manner during test execu-
tion.

+ A waveform made up of waveform diagrams on the Seq tab
concatenated together in order of execution sequence is
displayed (an image of the test waveform that does not include
the repetition of the Repeat all).

+ Inalong test, details of voltage dips and voltage fluctuations
may not be represented.

« The waveform colors correspond to the Seq tab colors.

« Trigger marks are not displayed.

« The repetition of the entire sequence is displayed as “execution
count/specified count” in the left edge of the waveform preview.

« Avertical bar shows the current execution point in the sequence.

Result list The test conditions that are being executed are displayed in a list
where each row contains the conditions of a different Seq tab.
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Setting Limits

You can set the PCR-LE's voltage limit, current limit, and protection (OVP and UVP) values from QIS2.

Limits can be placed on the PCR-LE Series output voltage setting. They prevent damage to the load
caused by mistaken operations and limit the current that flows through the load. You can set limits

in advance according to the load conditions.
In AC+DC mode, set AC limits and DC limits.

m - QIS2 stores the limit values and uses them the next time it starts. Because there are no stored
limit values the first time QIS2 starts, QIS2 will load the limit values from the connected PCR-LE.
« If you connect a PCR-LE with a different output capacity, you must change the limit values to

appropriate values.

1 On the Instruments menu, click Setting Limits.

The Setting Limits dialog box appears.

The appropriate wiring method tab is selected on the basis of the information of the con-

nected PCR-LE.

Model PCRS00LE
Wiring method | 1P2W

Qutput mode  |AC

2w | 1paw [ 3P |

Voltage Limits

Upper AC [305.0 \Y pC (431.0

Lower AC (0.0 i DC -431.0

Current Limits
Current Limit AC [5.50 A DC [3.85 |5

+ Peak Current Limit  |22.00 =
— Peak Current Limit  |-22.00 =] A

Trip Time 0

Protection Function

ovP ac (3355 =|v  pclaraa

HOREE

UvP AC (0.0 = v DC |-474.1

[ oK ] [ Cancel

2 Enter appropriate values in the boxes.

Information of
the connected PCR-LE

Wiring method tabs

You can select a different wiring method tab and enter limit values so that QIS2 stores

them.

3 Click OK.
Limit values are stored.
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Item

Setting Limits

Description

Voltage Limits

You will not be able to set output voltages outside the range
(defined by the lower limit and upper limit).

Set the limits so that the lower limit is less than or equal to the
upper limit.

During single-phase three-wire operation and three-phase opera-
tion, set the limits using phase voltages.

Upper and Lower

+ Input range (AC): 0.0 V to 305.0V
+ Inputrange (DC1): -431.0Vto 4300V

Current Limits

You can set the output current’s upper limit. You cannot set the
lower limit.

The limit operates on the rms value of the output current.

If the output current exceeds the current limit, the output is turned
off, and an alarm occurs.

Current Limit

« Input range (AC): 0.1 to x1.1 of the PCR-LE rated current (A)
- Input range (DC"): x0.1 to x1.1 of the PCR-LE rated current (A)

+ and - Peak Current
Limit

+ Input range: X0.1 to x4.4 of the PCR-LE rated current (A)

Trip Time

If the output current exceeds the current limit, the output is turned
off after the specified time elapses.

The amount time until the output is turned off may become large
due to the state of the load or the timing of the PCR-LE Series inter-
nal current measurement. Depending on the current measurement
response speed, there may be a delay of approximately 0.1 sec-
onds.

+ Inputrange:0sto10s

Protection Function

When the protection function is activated, the output is turned off,
and an alarm occurs.

During single-phase three-wire operation and three-phase opera-
tion, set the limits using phase voltages.

OvP

If the output voltage exceeds the OVP setting and remains there
for approximately 1 second, the output overvoltage protection will
be activated.

+ Inputrange (AC): 0.0V to 335.0V

+ Inputrange (DC"):-474.1Vt0 4741V

UvpP

If the output voltage drops below the UVP setting and remains
there for approximately 1 second, the output undervoltage protec-
tion will be activated.

+ Inputrange (AC): 0.0V to335.0V

- Input range (DC"): -474.1 V to 474.1 V

1 Only when the single-phase two-wire or single-phase three-wire tab is selected

/\CAUTION ° Risk of product malfunction. If a current limit or protection function is activated, remove all the
causes of the alarm before clearing the alarm.
To clear the alarm, click Alarm clear on the Instruments menu.
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Setting Test Conditions

Set the immunity test conditions. You can save the test conditions as a file, so you can recall previ-
ously created test conditions and use them when they are necessary. You can use the test condi-
tions setup pane to set conditions for each test standard, but this section will explain how to set the
settings that are common to all the tests.

/\CAUTION ° All voltage settings on QIS2 are phase voltages. In single-phase three-wire operation, the voltage
between lines is twice the specified voltage (phase voltage); in three-phase operation, the volt-

age between lines is /3 times the specified voltage (phase voltage).

Test conditions

Item

Description

Standard selection

Click the standard number button of the standard that you want to
select.

- IEC61000-4-11 Voltage dips, short interruptions, and voltage vari-
ations

+ |EC61000-4-13 Harmonics and interharmonics
«  |EC61000-4-14 Voltage fluctuation

« |EC61000-4-17 Ripple on d.c. input power port
« IEC61000-4-27 Unbalance

- |EC61000-4-28 Variation of power frequency

- IEC61000-4-29 Voltage dips, short interruptions, and voltage vari-
ations on d.c. input power port

- |EC61000-4-34 Voltage dips, short interruptions, and voltage vari-
ations

Seq tabs
(Seq 1to Seq 10)"

You can set the test conditions on Seq tabs (Seq 1 to Seq 10). You can
copy and paste values from one Seq tab to another.
The tab colors correspond to the colors of the preview waveforms. To
change the colors, on the Option menu, click Color.

Seq check boxes
(Seq 1to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you
want to execute. The tests are executed in order starting from Seq 1. Any
Seq tabs that you do not select will be skipped.

Output Off check box

Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

Combo boxes

To enter values, you can select from the list of representative values that
are displayed in the list. Alternatively, you can enter values directly into
the boxes (press Enter to confirm the value).

The eight most-recent values that have been entered are saved. When
you enter the ninth value, the oldest value is deleted. If you enter or
select from the list a value that is the same as one of those already
saved, this value is treated as the most recent value, and its position in
the order of values is changed to reflect this status.

Combo boxes that are not displayed on a specific Seq tab (Seq 1 to Seq
10) are shared between all Seq tabs. Set the voltage, frequency, and
number of times to repeat all tests. The voltage and frequency combo
boxes are displayed depending on the standard.

10
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QISs2

(NOTE

Item

Setting Test Conditions

Description

Trigger check boxes

Use these check boxes to enable trigger output. Red marks (<) are dis-
played at the selected positions. These marks indicate the timing that
trigger signals are generated from the PCR-LE. Use these when you are
using an oscilloscope to view the test signal. For details on trigger signal
output, see “Observing test signals.”

Repeat combo box

Set the number of times that the contents of the tab will be repeated.
You can specify a value from 1 to 999.

Repeat all combo box

Set the number of repetitions of the entire sequence. One repetition
consists of all the tests whose Seq check boxes have been selected. You
can specify a value from 1 to 9999.

Waveform preview?

The waveform of the selected Seq tab (Seq 1 to Seq 10) is displayed. The
vertical axis is scaled automatically. A maximum of approximately 90 %
of the display area is used to draw the graph. You can use the Zoom in
and Zoom out buttons on the toolbar to zoom in and out horizontally.
You can use the scroll bar to move to the location that you want to see.
The waveform colors correspond to the Seq tab colors.

Result list

The test conditions that are being executed are displayed in a list where
each row contains the conditions of a different Seq tab. Rows are added
to the result as the test execution moves from one Seq tab to the next
one. The result is scrolled automatically so that the added rows are dis-
played. The displayed items vary depending on the standard.

1 The following IEC61000-4-13 test items can only be set on the Seq 1 tab.
Frequency sweep, odd harmonics whose orders are not a multiple of 3, odd harmonics whose or-
ders are a multiple of 3, even harmonics, interharmonics, and meister curve

2 The test start point of the selected Seq tab (Seq 1 to Seq 10) is displayed at the left edge of the wave-
form preview. For example, if you select Seq 6, you can display the previews of Seq 6 to Seq 10.
When you zoom in horizontally, you can use the scroll bar to display the preview of the waveform
that you want to see. The display area is limited, so depending on the settings, you may not be able
to display all the waveforms. The Repeat all setting does not affect the waveform preview.

You can configure QIS2 so that the settings that you specify with the combo boxes on the Seq tab
are not easily changed. On the Options menu, click Display Options, and select the In a Seq tab
check box under Change Values. This will cause a confirmation message to be displayed when you

try to change the settings.

HTime unit

In test condition setup, all times are entered in units of seconds. The resolution is 0.001 s.

11
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Setting Test Conditions

Toolbar

=) d

Open Save Cond.

Item

© H 2 fien & g ¥
Run Stop Qutput | Range | Zoomin Zoom out | Abort

Description

Open

Displays a dialog box for selecting the test conditions file.

Save Cond.

Overwrites the open test conditions file with the present test conditions.

Run

Starts the test.
Alternatively, you can first click Output to turn the PCR-LE’s output on, and
then click Run to start the test.

Stop

Stops the test that is running. Note that this does not turn off the PCR-LE’s
output. To turn the output off as well, click Abort.

Output

Turns the PCR-LE output on and off. When the output is off, click Output to
turn the output on.

The initial voltage of the active Seq tab is output, so it is possible to exe-
cute tests when the output is on.

Range

Switches the voltage range. A Low range and a High range are available.
With the Low range, the maximum voltage is 152.5 V. With the High range,
the maximum voltage is 305.0 V.

« For the IEC61000-4-29 standard (voltage dips, short interruptions, and
voltage variations on d.c. input power port), this is DC voltage. With the
Low range, the maximum voltage is 215.5 V. With the High range, the
maximum voltage is 431.0 V.

Zoom in/Zoom out

Zooms horizontally the waveform that is displayed in the waveform pre-
view. You can use the Zoom in and Zoom out buttons to zoom in and out
horizontally.

When you have zoomed in as far as possible, the Zoom in button is unavail-
able. When you have zoomed out as far as possible, the Zoom out button is
unavailable. You can use the Zoom in and Zoom out buttons to change the
zoom setting to one of 9 levels.

Abort

Aborts the test that is being executed and turns the PCR-LE output off.
+ Inan emergency, turn the PCR-LE’s POWER switch off.
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QIS2

Setting Test Conditions

Progress bar and PCR-LE operation status display

[OUTMODE]|

AC

RANGE

Low

QUTPUT

ON

PHRSE

— |

Item

Description

Transmission prog-
ress bar (left bar)

Indicates the wait time until the test actually starts (the time during which
test conditions are sent to the PCR-LE) using a green bar.

Execution progress
bar (right bar)

Indicates the progress of the test since the test actually started using a
blue bar. The remaining time is displayed on the right side.

Indicates single-phase two-wire (1P2W) connection, single-phase three-
wire (1P3W) connection or three-phase (3P) connection.

QUTFUT

Indicates the output on/off status of the PCR-LE.

RANGE

Indicates the High/Low status of the PCR-LE'’s voltage range.

OUIT MODE |

ACDC

Indicates the output mode of the PCR-LE.

@

This is displayed when an alarm is detected.

PCR-LE output modes

On the Instruments menu, select the PCR-LE output mode.

dard 1P output 3P output

standar AC AC+DC' DC AC?

IEC61000-4-11 Yes Yes No Yes

IEC61000-4-13 Yes Yes No Yes

IEC61000-4-14 Yes Yes No Yes

IEC61000-4-17 No Yes No No

IEC61000-4-27 No No No Yes

IEC61000-4-28 Yes Yes No Yes

IEC61000-4-29 No Yes Yes No Yes: Can be executed
IEC61000-4-34 Yes Yes No Yes  No:Cannotbe executed

*1  Insingle-phase three-wire operation, AC+DC mode cannot be selected.
*2  Inthree-phase operation, only AC mode is selectable.

13



Setting Test Conditions
Saving test conditions as files

HOverwriting an existing file

Click Save Cond.

If you are saving a new file, the Save As dialog box appears. You cannot save the file with
the default file name (untitled.xml).

ESaving conditions with a new file name

1 On the File menu, click Save As (Test Condition).
The Save As dialog box appears.

2 Specify the save destination and the file name.

3 Click Save in the dialog box.
The test conditions are saved.

Recalling test conditions

1 Click Open.
The Open File dialog box appears.
0. 16 You can select whether to display a save confirmation message when the present test con-
ditions file has not been saved. On the Options menu, click Display Options, and select the
appropriate check box under Test Condition File.

2 Specify the file that you want to recall.

3 Click Open in the dialog box.
The test conditions are set to the conditions in the recalled file.

Qls2



Observing test signals

QIS2

To observe test signals on an oscilloscope, use the trigger signal output described below. The trig-
ger signals that you have selected with the test conditions of the standard are generated from the
PCR-LE.

BPCR-LE trigger signal output (SEQ TRIG OUT)

Trigger signal output is generated from the SEQ TRIG OUT terminal on the rear panel for several
tens of milliseconds. High level signals are approximately 5 V. Low level signals are approximately 0
V. There is a slight time difference (approximately 100 ps) between the trigger signal output and
changes to the actual output. Trigger signals may also be output when you change the contents of
a sequence. Use the PCR-LE configuration settings to set the signal polarity.

The BNC connector is isolated from the PCR-LE’s INPUT and OUTPUT terminal blocks. The common
line of the signals that flow through the BNC connector is shared inside of the PCR-LE. This common
line is also shared by the remote interfaces, except the LAN interface. Therefore, if you use a desktop
PC to control the PCR-LE remotely, the communication signal line of the PC is grounded, so the BNC
connector is also grounded. If the signal line that is connected to the BNC connector has an electri-
cal potential with respect to ground, the connected device or the PCR-LE may be damaged because
of the current that flows through the signal line.

PCR-LE rear panel Trigger output

( SEQ TRIG OUT
v A

SEQ STAT OUT

v A

SEQTRIG IN
5V MAX

HEDIP Simulator trigger signal output

If you are using the DSI1020/DSI3020 DIP Simulator, the trigger signal is generated from the TRIG
OUT terminal (BNC connector) on the rear panel. For details, see the DIP Simulator operation man-
ual.

15
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Display Options

You can specify various options in the Display Options dialog box.

On the Options menu, click Display Options.

Message of Show Options

Change Values Test Condition File

[C] Affect soon the Output Close Message
[[] In a Seq tab ) Show a Confirmation Message

[ Repeat all ) Always Overwrite (No Message)

@ Always unsave (No Message)
Warnings of Sequence Start and Output ON

[] Open Message
[7] When a Test Sequence Starts

[7] When this App is Started with Output ON Result File Save

[7] When this App is Closed with Output ON ) Show a Confirmation Message
[7] when the Output Turns ON @ Always unsave

Wave Preview Pane Option

Display Wave Progress

Iltem Description
Message of Show Options
Change Values A message appears when you change the value of an item whose

check box is selected.

- Affect soon the Output:

When you change the PCR-LE output setting on the test conditions
setup pane.

+ InaSeqtab:

When you change a combo box value on the Seq tab.

+ Repeatall:

When you change the number of repetitions of the entire
sequence to be executed.

F_Quick Immunity Sequencer 2

1 Dip Cycle in Segl will be changed. Do you accept?
\q) From 1.0 to 2.0

[ OK ] [ Cancel

Message example

Warnings of Sequence A message appears when the item whose check box is selected
Start and Output ON applies to the present QIS2 condition.

+ When a Test Sequence Starts

« When this App is Started with Output ON

+ When this App is Closed with Output ON

« When this Output Turns ON

Qls2
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Item

Display Options

Description

Test Condition File

Close Message

You can select how the QIS2 behaves when you close it without
saving a test conditions file that has been changed or when you
open a different test condition file.

+ Show a Confirmation Message:

You can select whether to save the file.

+ Always Overwrite (No Message):

The file is overwritten without a message.

For a new file, you assign the file name before saving it.

+ Always unsave (No Message):

The file is not updated. Nor is a message displayed.

Open Message

If selected, a message appears when you open a different test con-
ditions file.

Result File Save

You can select how QIS2 behaves when you save a test result file.
+ Show a Confirmation Message:

You can select whether to save the file.

+ Always unsave:

A save confirmation message is not displayed.

Wave Preview Pane Option

Display Wave Progress

If checked, only during test execution, a waveform made up of
waveform diagrams on the Seq tab concatenated together in order
of execution sequence is displayed in the waveform preview pane
(an image of the test waveform that does not include the repeti-
tion of the Repeat all).

The line cursor moves along with the test progress.

17
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Executing Tests

Before executing tests

/\CAUTION

- Because QIS2 uses waveform banks (0 to 63), the waveform data stored in the waveform banks

will be overwritten." If you have already used the waveform banks on the PCR-LE by itself and

have stored important data in the waveform banks, we recommend that you use the Wave Bank

Memory application software to save the waveform data to a separate location such as a PC'’s
hard disk.

1 Output waveform data is stored in the PCR-LE internal memory. The memory area for stor-
ing the data of one waveform is referred to as a waveform bank. The PCR-LE has 64 wave-
form banks (0 to 63). QIS2 uses all the waveform banks (0 to 63).

Sine wave data that is used as the PCR-LE’s reference voltage waveform is stored in wave-
form bank 0. In the factory default settings, all waveform banks have the same waveform
(sine wave) as the one that is stored in waveform bank 0.

Depending on the test conditions, QIS2 may overwrite the data in waveform bank 0 with
data that is not a sine wave. This is not a problem while the PCR-LE is being used from QIS2.
If you want to use the PCR-LE in a standalone manner immediately after you finish testing,
turn the PCR-LE’s POWER switch off and on to return the data in waveform bank 0 to the sine
wave data.

Turning the power on and off

/\CAUTION

+ Turning the power on and off incorrectly may lead to errors or damage to the PCR-LE. Follow t
procedures below to turn the power on and off.

he

HTurning the power on

1 Turn on the DIP Simulator.

2 Turn on the PCR-LE.

When you are using the DIP Simulator, you have to turn the PCR-LE’s output off to cha
the DIP Simulator settings.

3 Start QIS2.

nge

When you are using the DIP Simulator, the PCR-LE output will be turned on automatically even if it

is off when you execute the test.
ETurning the power off

1 Exit QIS2.

2 Turn off the PCR-LE.

3 Turn off the DIP Simulator.

Qls2



[see]p. 16

QIS2

Executing Tests

Turning the PCR-LE output on and off

If you click the Output button on the toolbar, you can start a test with the PCR-LE output turned on.
To turn off the output, click the Output button again.

(\Ta]

When the output is on, if you change the PCR-LE output voltage or frequency on the test conditions
pane, it is immediately reflected in the output. To configure QIS2 so that the output cannot be
changed easily, on the Options menu, click Display Options, and select the Affect soon the Output
check box under Change Values. This will cause a confirmation message to be displayed when you
try to change the voltage or frequency.

Text execution and output-on warning messages

In the dialog box that appears when you click Display Options on the Options menu, you can have
warning messages appear for the following conditions (multiple conditions can be selected).

+ When a test is started

« When QIS is started with the output turned on
« When QIS is closed with the output turned on
+  When the output is turned on

19
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Executing Tests

Execution

NOTE

7 Seq 1 The tests that correspond to the selected Seq tab check boxes are exe-
7] Seq 2 cuted in ascending order according to the Seq tab numbers. Any Seq
j geq i tabs that you do not select will be skipped.

eq
7] Sea 5 In the example shown on the left, Seq 1 to Seq 7 will be executed in
/| Seq & ascending order. Repeat all is set to 1. Therefore, the test is finished
b

Sea’  All seq when the execution of Seq 7 is complete.

Seq 8
Seq 9 iheken The Output Off check box is not selected, so the PCR-LE output will
Sea10  [uncheck | remain on when the test is finished.

Seq End

Qutput Off
Freg [Hz] 50.00 -
Repeat all 1 -

+ The following IEC61000-4-13 tests are executed while rewriting between waveform banks.

Frequency sweep, odd harmonics whose orders are not a multiple of 3, odd harmonics whose
orders are a multiple of 3, even harmonics, interharmonics, and meister curve

It takes a little less than 2 seconds to rewrite between waveform banks. Waiting for waveform
bank rewriting is performed with the execution timing of the integer-order harmonics. QIS2
rewrites between up to 64 banks, so there is a maximum wait time of approximately 2 minutes
while the integer-order harmonics are generated.

To configure QIS2 so that the number of repetitions of the entire sequence cannot be changed
easily, on the Options menu, click Display Options, and select the Repeat all check box under
Change Values. This will cause a confirmation message to be displayed when you try to change
the number.

[seelp.7,p. 16

1 Set the test conditions.

2 On the toolbar, click Run.

First, the transmission of test conditions to the PCR-LE begins. The transmission progress
bar shows the progress.

When the transmission is complete, the test begins. The execution progress bar shows the
progress. The remaining test time is displayed to the right of the execution progress bar.
The display in the Waveform preview pane varies depending on whether the Display
Wave Progress check box is selected under Wave Preview Pane Option in the Display
Options dialog box.

QISs2



Executing Tests

Transmission progress bar Execution progress bar

2, Test00Lxmi - Quick Immuni e
File Edit Instruments Option Help

5 d o L & ¥
Open_saveCond. | Run__ stop | output | Range  Zoomin zo\mout | Abort
[oUTHo0E | Fowae [ oureur | PE \ 7 Remain 05:46
‘ ACDC|| Low | ON IP2W| u
[ seq1 == Seq 1 == Seq2 | mm Seq3|mm Seq4 [mm Seq 5 |mm 5eq6 == Seq 7 [mm Seq 8| == Seq o= Seq 10
e

© Voltage dips L
Short interruption 1000 -joyde
Voltage variation I

nterval

000-4-13
10000 ~Js

SeqE
O output off

| Trigger
Frealte] (5000 <] . 5 o

Repeatal [z -]

repeat
| m
| Ilm
\

Test item educed]
joltage dips

Level Angle
VTV | o) | Tdeg)
1000 | 400 | o

Decreasing
[s]

(v |Increasing [s] | Interval [s]

100.0 ¢y

10.000

Wave progress bar

When the “Display Wave Progress” check box is checked

Stop

1 On the toolbar, click Stop.

Dealing with unusual circumstances

If an unusual circumstance occurs on the EUT, stop the test from QIS2 and the hardware. To ensure
that the EUT is protected, we recommend that you stop the test from the hardware.

®From QIS2
To stop the test, press function key F9 or click Abort on the toolbar. This will turn the PCR-LE output
off.

®From the hardware
Turn the PCR-LE POWER switch off.

QIs2
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Executing Tests

Result list

The test conditions that are being executed are displayed in a list where each row contains the con-
ditions of a different Seq tab or a different superimposed harmonic. Rows are added to the result as
the test execution moves from one Seq tab or superimposed harmonic to the next one. The result is
scrolled automatically so that the added rows are displayed. The displayed items vary depending
on the specification.

Here we will show a representative example of a test. Unrelated values are displayed as a blank or as
0. A number, which is displayed under “No." is assigned for each test condition. This number
increases with each new test condition. The number of repetitions that is set on the Seq tab is not
displayed.

®\/oltage variations, voltage dips, and short interruptions example

No. Repeat all Seq Test item UT [V] Level [%]

1 1 1 Voltage variations 230.0 40.0

2 1 2 Voltage dips 230.0 70.0

3 1 3 Short interruptions 230.0 0.0

Angle [°] Decreasing [s]  Reduced Increasing [s] Interval [s]
(cy: cycles)

- 2.000 1.000 s 2.000 10.000

0 1.0cy 10.000

0 - 0.5cy - 10.000

Saving the test result

(\Ta]

If you do not need to save the test results, on the Options menu, click Display Options, and select
the Always unsave check box under Result File Save. The save confirmation message will no longer
appear.

Quick Immunity Sequencm M

L)) ile?
‘_:/ Do you save test result file?

[ Yes ] [ No ]

Qls2
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Executing Tests

EConfiguring the test result file options

On the File menu, click Test result file Options.
The Result File Options dialog box appears.

Result File Options \EI
Separator
) Comma @ Comma + Space
() Semicolon () Semicolon + Space
) Tab
Character code
@ Unicode (UTF-8) ) Japanese (Shift-11S)
Extension
@ txt © csv

2 Specify the Separator, Character code, and Extension.

3 Click OK.

WSaving the result with a new file name

1 On the File menu, click Save as (Test Result).
The Save As dialog box appears.

2 Specify the save destination and the file name.

3 Click Save.
The test results are saved.
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IEC61000-4-11

Test overview

The voltage dips, short interruptions, and voltage variation immunity tests test the immunity of a
device against sudden and gradual power supply voltage drops.

This standard is divided into two standards depending on the input current per phase. IEC61000-4-
11 is the standard for currents of 16 A or less. IEC61000-4-34 is the standard for currents that exceed
16 A. QIS2 does not differentiate test conditions according to the input current per phase. One test
result file is created for each standard.

INOTE For IEC61000-4-11 tests, we recommend that you use the DIP Simulator for the following reasons.
« The standard’s specifications for the voltage generator’s voltage rise and fall times (1 ps to 5 ps)
will be met. The voltage rise and fall times will be approximately 30 ps if you do not use the DIP

Simulator.

Voltage dips and short interruptions

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Iltem Description

Seq tab You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Test item Select Voltage dips or Short interruption.

Phase select Select the phase (phase voltage or line voltage) for setting the test conditions.
(Three-phase The selection of phase voltage or line voltage applies to all Seq tabs. To use a

operation only)'  DIP simulator, set it in each Seq tab.
If you select the short interruptions test, short interruptions will occur at the
same time on all phases.

If phase voltage is selected in the voltage dips test

« Select which phase to dip the voltage, Ua, Ub, or Uc (multiple sections
allowed).
To apply this setting to all Seq tabs, click the Copy button.

If line voltage is selected in the voltage dips test

« Select between which two lines to dip the voltage, Ua-Ub, Ub-Uc, or Uc-Ua
(multiple selections not allowed).
To apply this setting to all Seq tabs, click the Copy button.
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Item

IEC61000-4-11

Description

UT (Phase) [Vrms]

Enter the initial voltage (the recovery voltage is the same value). Normally

enter the rated voltage of the EUT.

« Inputrange: 50.0 Vto 305.0V

+ Input range (when using the DIP Simulator): 50.0 s to 288.0 V

» You have to select an appropriate voltage range. Use the toolbar or the
Instruments menu to set the voltage range.

« Check the Seq tabs’ UT settings that will be used when the test is executed.
If the UT settings are different on different Seq tabs, unintended voltage
variations will occur depending on the Seq tabs that have been selected for
execution.

In single-phase, three-wire operation or if Phase select is set to Line voltage in
three-phase operation, the phase voltage that you enter is converted to a line
voltage and displayed in blue under the box.

Level (Phase or
Line) [%]

For the voltage dips test, enter the level that the voltage will be reduced to as

a percentage of UT. For the short interruptions test, this is fixed to 0 % (you

cannot enter the value).

- Input range (voltage dips): 0.0 % to 200.0 % (0.0 % to 100.0 % with setting of
line voltage)

« Input value (when using the DIP Simulator): 0.0 %, 40.0 %, 70.0 % or 80.0 %

Change angle []

Enter the starting phase angle for the voltage dip or short interruption.
« Inputrange:0°to 359°

Dips or Short Enter the number of cycles of the voltage dip or short interruption. The number

[cycles] of cycles that you enter is converted to time and displayed in blue under the box.
« Input range (voltage dips): 0.1 cycles to 10000.0 cycles
« Input range (short interruptions): 0.1 cycles to 10000.0 cycles
+ Input range (when using the DIP Simulator):

The DIP Simulator can be set to -0.5 cycles, 0.5 cycles or a value from 1 cycle
to 300 cycles.

Interval [s] Enter the interval between the time when the voltage returns to the recovery
voltage (UT) and the time when the next voltage drop will occur. The last
interval is the transition time to the next Seq tab.

« Input range: 0.0200 s to 360000.000 s

« Input range (when using the DIP Simulator): 10.000 s to 100.000 s
(The resolution is 1 s, rounded to the nearest integer.)

« To detect zero crossings, depending on the settings, the actual interval may
be the interval that you set plus the time of one period.

Repeat Enter the number of repetitions of the Seq tab.

« Input rangezz 1 repetitions to 999 repetitions
Trigger Select the trigger signal output. Red marks (<) are displayed at the positions

that you select with the check boxes. They are also displayed on the waveform
preview.

Seq check boxes
(Seq 1toSeq 10)

Select the check boxes that correspond to the Seq tabs whose tests you want
to execute. The tests are executed in order starting from Seq 1. Any Seq tabs
that you do not select will be skipped.

Output Off

Select this check box to turn off the test signal when tests are finished. (This
turns off the PCR-LE output.)

Freq [Hz]

Enter the rated frequency of the EUT.

+ Input range: 45.00 Hz to 65.00 Hz

+ Input value (when using the DIP Simulator):
Select 50.00 Hz or 60.00 Hz.

Repeat all

Enter the number of repetitions of the entire sequence, which is made of the
selected tabs from Seq 1 to Seq 10.
« Input range: 1 repetition to 9999 repetitions

1 To use the ITO1-PCR-L Immunity Tester, you need to change the connection.
Phase voltage: Connect an Immunity Tester to each phase.
Line voltage: Connect an Immunity Tester between each line.

2 3 repetitions to 999 repetitions (multiples of 3 only) for the ITO1-PCR-L.
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IEC61000-4-11

Voltage variations

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Iltem Description

Seq tab The same as the description given under “Voltage dips and short interrup-
tions.”

Test item Select Voltage variations.

Phase select
(Three-phase
operation only)

Select the phase (phase voltage or line voltage) for setting the test conditions.
The selection of phase voltage or line voltage applies to all Seq tabs. To use a
DIP simulator, set it in each Seq tab.

If phase voltage is selected

«» Select which phase to dip the voltage, Ua, Ub, or Uc (multiple sections
allowed).
To apply this setting to all Seq tabs, click the Copy button.

If line voltage is selected

«+ Select between which two lines to dip the voltage, Ua-Ub, Ub-Uc, or Uc-Ua
(multiple selections not allowed).
To apply this setting to all Seq tabs, click the Copy button.

UT (Phase) [Vrms]

Level (Phase or
Line) [%)]

The same as the description given under “Voltage dips and short interrup-
tions.”

Decreasing [s]

Enter the time for decreasing the initial voltage (UT) to the low voltage.
« Input range: 0.0 s to 360000.000 s

Reduced [s]

Enter the duration of the low voltage.
« Input range: 0.01 s to 360000.000 s

Increasing [s]

Enter the time for recovering the voltage from the low voltage to a value that
is the same as the initial voltage (UT).
« Input range: 0.01 s to 360000.000 s

Interval [s]

Repeat

Trigger

The same as the description given under “Voltage dips and short interrup-
tions.”

Seq check boxes
(Seq 1to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you want
to execute. The tests are executed in order starting from Seq 1. Any Seq tabs
that you do not select will be skipped.

Output Off

Freq [Hz]

Repeat all

The same as the description given under “Voltage dips and short interrup-
tions.”

(\Ta]

At the start of a test, the phases are aligned so that they start with the same phase, but depending
on the time setting, the starting phases may be different in the next sequence or repetition.
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Test overview

QIS2

The harmonics and interharmonics immunity tests test the immunity of a device against power
supply voltage waveform distortion. The test items are shown below.

+  Flatcurve

+  Overswing

+ Frequency sweep

«  0Odd harmonics whose orders are not a multiple of 3
« 0dd harmonics whose orders are a multiple of 3

«  Even harmonics

+ Interharmonics

+  Meister curve

BTest order

The standard indicates a recommended test order of the test items in a flow chart. This test order
has not been incorporated in QIS2 so that it can be used for other purposes such as preliminary
testing. QIS2 has been designed so that each test item can be tested individually.

HElectromagnetic class

QIS2 is not designed for a particular class. It also does not have conditions for setting the class. Set
appropriate test conditions for your EUT.

EThree-phase operation

The test conditions are all set in relation to U-phase. Test signals change simultaneously in three-
phases on the basis of U-phase.
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Flat curve

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Iltem Description

Seq tab You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Test item Select Flat curve.

xU1 x Ky x A2 Enter the clipping voltage as a percentage of the U1 peak value,
(flat voltage) “U1 x Ky x 2 " To not clip the signal, set this to 1. Even if the test level is

changed, the Ky value is automatically adjusted to maintain the RMS value
at the U1 value.
« Input range: 0.40 to 0.99

Duration [s]

Enter the duration of the flat-curve waveform.

« Input range: 0.020 s to 360000.000 s

« Waveforms are switched when the fundamental wave's phase angle is
0 °. In other words, the present waveform is not switched when the set
time elapses, but when the fundamental wave's phase angle next
becomes0°.

Interval [s]

Enter the interval between the time when the voltage returns to the

recovery voltage (U1) and the time when the next waveform clipping will

occur. The last interval is the transition time to the next Seq tab.

+ Inputrange: 0.020 s to 360000.000 s

« Waveforms are switched with the same timing as was explained for the
duration.

Repeat

Enter the number of repetitions of the Seq tab.
« Inputrange: 1 repetition to 999 repetitions

Trigger

Select the trigger signal output. Red marks () are displayed at the posi-
tions that you select with the check boxes. They are also displayed on the
waveform preview.

Seq check boxes
(Seq 1to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you
want to execute. The tests are executed in order starting from Seq 1. Any
Seq tabs that you do not select will be skipped.

Output Off

Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

U1 [v]

Enter the initial voltage (the recovery voltage is the same value). Normally

enter the rated voltage of the EUT.

« Inputrange: 50.0 V to 305.0V

» You have to select an appropriate voltage range. Use the toolbar or the
Instruments menu to set the voltage range.

Freq [Hz]

Enter the rated frequency of the EUT.
« Input range: 45.00 Hz to 65.00 Hz

Repeat all

Enter the number of repetitions of the entire sequence, which is made of
the selected tabs from Seq 1 to Seq 10.
« Inputrange: 1 repetition to 9999 repetitions
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Over swing

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item Description

Seq tab The same as the description given under “Flat curve!

Test item Select Over swing.

Level [%] Enter the voltage levels of the third-order and fifth-order harmonics that

will be superimposed on the fundamental wave as percentages of UTrms.
« Input range: 0.0 % to 100.0 %
« Even if you change the test level, RMS is maintained at the U1 value.

Angle [°] Enter the phase angles of the third-order and fifth-order harmonics that
will be superimposed on the fundamental wave.
+ Inputrange: 0°to 360 °

Duration [s]

Interval [s]

Repeat

Trigger

Seq check boxes
(Seq 1 to Seq 10)

Output Off
U1 [V]
Freq [Hz]
Repeat all

The same as the description given under “Flat curve!

QIS2
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IEC61000-4-13

Sweep in frequency

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Iltem Description

Seq tab You can set the test conditions on the Seq 1 tab only.

Test item Select Sweep in frequency.

Af (harmonic step) Enter the step of the sweeping of the harmonics or interharmonics that

will be superimposed on the fundamental wave (enter this as a differ-
ence of orders). The sweep proceeds in ascending order from lower
orders to higher orders.

+ Inputrange:0.1t0 1.0

Level [%] Enter the levels of the harmonics that will be superimposed on the fun-
damental wave as percentages of the fundamental wave.
+ Input range: 0.0 % to 100.0 %

Time [s/block] For each frequency range, enter the duration of the sweeping of the
harmonics or interharmonics that will be superimposed on the funda-

mental wave.

+ Input range: 300.000 s to 360000.000 s

+ Waveforms are switched when the fundamental wave’s phase angle
is 0 °. In other words, the present waveform is not switched when the
set time elapses, but when the fundamental wave’s phase angle next
becomes 0 °.

Trig Out (trigger output) Select the trigger signal output. A trigger signal is generated when the
multi-layering of integer-order harmonics starts. On the waveform pre-
view, red marks (<) are displayed at the positions that you select with
the check boxes.

Seq check boxes You can only select the Seq 1 check box. All check boxes other than Seq

(Seq 1 to Seq 10) 1 are unavailable.

Output Off Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

U1 [Vl Enter the initial voltage (the recovery voltage is the same value). Nor-

mally enter the rated voltage of the EUT.

+ Inputrange: 50.0Vto 305.0V

+ You have to select an appropriate voltage range. Use the toolbar or
the Instruments menu to set the voltage range.

Freq [Hz] Enter the rated frequency of the EUT.
+ Input range: 45.00 Hz to 65.00 Hz

1 The available frequency ranges are the five frequency ranges in the “Harm order” column: 0.33 to 2.0,
2.0to 10.0, 10.0 to 20.0, 20.0 to 30.0, and 30.0 to 40.0).
If Afis 0.1, the value after 0.33 is 0.4.
Regardless of the Af setting, QIS2 always superimposes integer orders.
The next waveform is created while integer-order harmonics are being generated.
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QIS2

IEC61000-4-13

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

ltem Description

Seq tab The same as the description given under “Sweep in frequency.”

Test item Select “Odd, non multiple of 3" or “Odd, multiple of 3"

Harm. Enter the harmonics that will be superimposed on the fundamental
wave. Individual harmonic changes are performed starting from the
top-most row in the table and proceeding to the bottom.

« Input range (Odd, non multiple of 3):
The setting is fixed to the following sequence: 5,5,7,7,11,13,17,19,
23, 25, 29, 31, 35, 37. You cannot change this setting.

« Input range (Odd, multiple of 3):
The setting is fixed to the following sequence: 3, 3,9, 9, 15, 21, 27, 33,
39. You cannot change this setting.

Level [%] Enter the levels of the harmonics that will be superimposed on the fun-
damental wave as percentages of the fundamental wave.
+ Input range: 0.0 % to 100.0 %

Angle [°] Enter the phase angles of the harmonics that will be superimposed on
the fundamental wave.

+ Inputrange:0°to 360°

Duration [s] Enter the duration of the harmonics that will be superimposed on the
fundamental wave.

+ Input range: 0.000 s to 360000.000 s

« Waveforms are switched when the fundamental wave's phase angle
is 0 °. In other words, the present waveform is not switched when the
set time elapses, but when the fundamental wave's phase angle next
becomes 0 °.

Interval Enter the wait time until the next harmonic is superimposed. During
this interval, only the fundamental wave is generated.

« Input range: 0.000 s to 360000.000 s

» Waveforms are switched with the same timing as was explained for
the duration.

If you set the duration or the interval to 0.000 s, the corresponding step

will be skipped.

Trig Out (trigger output) Select the trigger signal output. Trigger signals are generated at the

start of the superimposing of the harmonics that you select with the

check boxes. On the waveform preview, red marks (<) are displayed
at the positions that you select with the check boxes.

Seq check boxes
(Seq 1 to Seq 10)

Output Off

u1[Vv]

Freq [Hz]

Repeat all

The same as the description given under “Sweep in frequency.”
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IEC61000-4-13

Even harmonics

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item

Description

Seq tab

The same as the description given under “Sweep in frequency.”

Test item

Select Even harmonics.

Harm.

Enter the harmonics that will be superimposed on the fundamental
wave. Individual harmonic changes are performed starting from the
top-most row in the table and proceeding to the bottom.

+ Input range: Even numbers from 2 to 40

Level [%]

Angle [°]

Duration [s]

Interval

Trig Out (trigger output)

The same as the description given under “Odd harmonics.”

Seq check boxes
(Seq 1to Seq 10)

Output Off

U1 [Vv]

Freq [Hz]

Repeat all

The same as the description given under “Sweep in frequency.”

Interharmonics

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item

Description

Seq tab

The same as the description given under “Sweep in frequency.”

Test item

Select Interharmonics.

Af (harmonic step)

The same as the description given under “Sweep in frequency.”

Level [%]

Enter the levels of the harmonics that will be superimposed on the fun-
damental wave as percentages of the fundamental wave.
+ Inputrange: 0.0 % to 100.0 %

Time [s/step]

Enter the duration (per step) of the interharmonics that will be super-
imposed on the fundamental wave.
+ Input range: 5.000 s to 360000.000 s

Interval [s/step]

Enter the wait time until the next interharmonic is superimposed (the
wait time until the next step). During this interval, only the fundamen-
tal wave is generated.

+ Input range: 0.000 s to 360000.000 s

Qls2
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Description

Trig Out (trigger output)

Seq check boxes
(Seq 1 to Seq 10)

Output Off

u1[V]

Freq [Hz]

The same as the description given under “Sweep in frequency.”

Meister curve

QIS2

Select or enter values that are within the selectable ranges for the values shown on the screen. If

you enter a value, press Enter to confirm it.

Item Description
Seq tab The same as the description given under “Sweep in frequency.”
Test item Select Meister curve.

Af (harmonic step)

The same as the description given under “Sweep in frequency.”

Level [%]

Enter the levels of the harmonics that will be superimposed on the fun-
damental wave as percentages of the fundamental wave.

If you specify a value between 0.0 and 99.9, that value will become the
level percentage.

If you specify a value between 100 and 5000, the level percentage will
be calculated from “input value/f”

Time [s/block] For each frequency range, enter the duration of the sweeping of the
harmonics or interharmonics that will be superimposed on the funda-
mental wave.!

« Input range: 300.000 s to 360000.000 s

Trig Out (trigger output)

Seq check boxes
(Seq 1 to Seq 10)

Output Off

U1 [V]

Freq [Hz]

The same as the description given under “Sweep in frequency.”

1 The available frequency ranges are the four frequency ranges in the “Harm order” column: 0.33 to
2.0,2.0to 10.0, 10.0 to 20.0, and 20.0 to 40.0).
If the Afis 0.1, the value after 0.33 is 0.4.
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Test overview

The voltage fluctuation immunity test tests the immunity of a device against power supply voltage
fluctuation.

BElectromagnetic class

QIS2 is not designed for a particular class. It also does not have conditions for setting the class. Set
appropriate test conditions for your EUT.

EThree-phase operation

The test conditions are all set in relation to U-phase. Test signals change simultaneously in three-
phases on the basis of U-phase.

Voltage fluctuation

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item Description

Seq tab You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Test item Select the Voltage fluctuation.

Un [%] Enter the center value of the voltage fluctuation. Enter this as a percentage of
the EUT's rated voltage.

+ Input range: 50.0 % to 150.0 %

+ Check the Seq tabs’ Un settings that will be used when the test is executed.
If the Un settings are different on different Seq tabs, unintended voltage
variations will occur depending on the Seq tabs that have been selected for
execution.

Deltal, Delta2, Enter the voltage fluctuation ranges. Enter these as percentages of the EUT's
and Delta3 [%)] rated voltage.

+ Input range: -50.0 % to 50.0 %

+ The duration is fixed to 2 s.

Repetition Enter the repetition intervals of the voltage fluctuation. Enter these in units of
(Repetition1, seconds or in the format of hours:minutes:seconds.

Repetition2,and -« Inputrange: 3.000 s to 360000.000 s

Repetition3) [s]

Repeat Enter the number of repetitions of the Seq tab.
« Input range: 1 repetition to 999 repetitions

Trigger Select the trigger signal output. Red marks () are displayed at the positions
that you select with the check boxes. They are also displayed on the waveform
preview.

Seq check boxes  Select the check boxes that correspond to the Seq tabs whose tests you want
(Seq 1toSeq 10) to execute. The tests are executed in order starting from Seq 1. Any Seq tabs
that you do not select will be skipped.

Output Off Select this check box to turn off the test signal when tests are finished. (This
turns off the PCR-LE output.)
Un [V] Enter the rated voltage of the EUT.

+ Input range: 0.0 Vto 300.0 V
+ You have to select an appropriate voltage range. Use the toolbar or the
Instruments menu to set the voltage range.
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ltem Description
Freq [Hz] Enter the rated frequency of the EUT.
 Input range: 45.00 Hz to 65.00 Hz
Repeat all Enter the number of repetitions of the entire sequence, which is made of the

selected tabs from Seq 1 to Seq 10.
« Input range: 1 repetition to 9999 repetitions

Interval

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

ltem Description

Seq tab The same as the description given under “Voltage variations.”

Test item Select Interval.

Un X [%)] Enter the center value of the voltage fluctuation. Enter this as a percent-
(Interval1) age of the EUT’s rated voltage. Normally, this is the same as the Un per-

centage on the previous Seq tab.

« Input range: 1.0 % to 150.0 %

+ Check the Seq tabs’ Un settings that will be used when the test is exe-
cuted. If the Un settings are different on different Seq tabs, unintended
voltage variations will occur depending on the Seq tabs that have been
selected for execution.

Un x [%] Enter the center value of the voltage fluctuation. Enter this as a percent-
(Interval2) age of the EUT’s rated voltage. Normally, this is the same as the Un per-
centage on the next Seq tab.
+ Input range: The same as the description given under “Un x [%]

(Interval1).”
Interval1 and Enter the intervals.
Interval2 [s] «+ Input range: 0.0010 s to 360000.0000 s
Repeat
Trigger

Seq check boxes
(Seq 1 to Seq 10)

Output Off
Un [V]
Freq [Hz]
Repeat all

The same as the description given under “Voltage fluctuation.”

QIS2
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Test conditions setup example

This section explains the procedure for setting the test conditions to generate the sequential volt-
age variations shown below.

Seq 1 | Seq 2 | Seq 3 Seq 4 Seq 5 Seq 6 Seq7

Un + 10 %

uUn -10 %

Example of sequential voltage variations

1 Select the Seq 1 to Seq 7 check boxes.

Seq 1
Seq 2
Seq 3
Seq 4
Seq 5
Seq 6
Seq7  allseq

S ]
et
[ seato

This procedure uses seven Seq tabs.

2 Configure the Seq 1 tab settings as indicated below.

== Seq 1 (mm Seq2 [~ Seq3| Seq4[== Seq5| Seq6|mm Seq7 |mm seq [*

@ Voltage fluctuation 4 Deltal Delta2 Delta3
8.0 * % -8.0 - % 8.0 * %

Unx 100.0 +~ %

) Interval

-

Repetition2 | Repetition3

4
it it L4

5.000 = s 5.000 * 5

" Repetition1
Repeat 1 - M

5000 =-s

Trigger
oEE
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3 Configure the Seq 2 tab settings as indicated below.

seq 3|

|m=Seq 1] == Sea2 |
@ Voltage fluctuation
@ Interval
Repeat 1 -
Trigger
o

Seq4|—Seq5| Seq6|—Seq7|—Seq‘ "
. Deltal Delta2 Delta2
-8.0 «~ % 8.0 ~ % -8.0 - %
i
.rf
| ™
Unx 100.0 - %
Repetition1 | Repetition2 | Repetition2 N
¢ it »
5.000 v 5 5.000 v 5 5.000 v 5

4 Configure the Seq 3 tab settings as indicated below.

-Seqll- Seq 2

0 Voltage fluctuation
@ Interval

Repeat 1 -

Trigger

oa

Seq3|

Seq4|- Seq5|

Seq6|-Seq?|-Seq 0] 14

1
Un % 100.0 + % (Intervall)

Un x 90.0 « % (Interval2)
Intervall Interval2 N
60.000 - s 60.000 « s

5 Configure the Seq 4 tab settings as indicated below.

|-Seqll-Set]2|

Seqg

@ Voltage fluctuation

@) Interval

Repeat 1 -

Trigger
Oooo

3| Seq4 |mm Seq 5| == Seq6 |mm Seq 7 | == Seql |
& Deltal Deltaz Delta3
8.0 - % 8.0 - % 8.0 - %
| »
Unx 90.0 =~ %
., Repetition1 A Repetition2 " Repetition3 N
5.000 - 5 5.000 - 5 5.000 - 5

IEC61000-4-14
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6 Configure the Seq 5 tab settings as indicated below.

|mm Seq1|mm seq2[== seqg3| Seqa|™ Seq5 |~ Seqs|mm Seq7 |mm Seq |’

) Voltage fluctuation
@ Interval
1
Un % 100.0 - % (Intervall)
Un x 110.0 = % (Interval2)

Intervall | Interval2 N
Repeat 1 - M L L4

60.000 « s 60.000 « s
Trigger
oo

7 Configure the Seq 6 tab settings as indicated below.

|mm Seq1|mm Seq2 [+ Seq3| Seq4[== Seq5| ™ Seq6 |mm Seq7 |mm Seq |’

@ Voltage fluctuation 4 Deltal Deltaz Delta3
- -8.0 - % -8.0 - % -8.0 - %
@) Interval
.'r.=
Unx 110.0 = %
" Repetition1 o Repetitionz | Repetition3
Repeat 1 - * LA\ Ldh L4
5.000 v 5 5.000 v 5 5.000 v 5
Trigger
o e

8 Configure the Seq 7 tab settings as indicated below.

[mm Seg1|mm Sag2 == seqg3| Sseq4[== seqs5|[== seq6| ™= Seq7 [mm Seql [’

@) Voltage fluctuation
@ Interval
1
Un x 100.0 = % (Intervall)
Un x 100.0 + % (Interval2)

Intervall L Interval2 N
Repeat 1 - it »

5.000 -~ 5 5.000 - 5
Trigger
[y
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Test overview

The ripple immunity test tests the immunity of a device against the ripple on its DC input power
port.

You cannot select this test in three-phase operation.

HElectromagnetic class

QIS2 is not designed for a particular class. It also does not have conditions for setting the class. Set
appropriate test conditions for your EUT.

Ripple on single-phase and three-phase rectifier circuits

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item Description
Seq tab You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).
Test item Select the appropriate rectifier circuit.
Udc [V] Enter the nominal DC voltage.
« Inputrange: 10.0 V to 360.0 V
Level [%] Enter the ripple pp (peak-to-peak) value as a percentage of the nominal

DC voltage (of the fundamental wave).
+ Input range: 0.0 % to 20.0 %

Duration [s] Enter the duration.
« Input range: 1.000 s to 360000.000 s
Interval [s] Enter the interval from the end of the duration to the start of the next

duration. The last interval is the transition time to the next Seq tab.
« Input range: 0.000 s to 360000.000 s

Repeat Enter the number of repetitions of the Seq tab.
« Input range: 1 repetition to 999 repetitions

Trigger Select the trigger signal output. Red marks () are displayed at the posi-
tions that you select with the check boxes. They are also displayed on the
waveform preview.

Seq check boxes Select the check boxes that correspond to the Seq tabs whose tests you

(Seq 1 to Seq 10) want to execute. The tests are executed in order starting from Seq 1. Any
Seq tabs that you do not select will be skipped.

Output Off Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

Freq [Hz] Enter the rated frequency of the EUT.
 Input range: 45.00 Hz to 65.00 Hz

Repeat all Enter the number of repetitions of the entire sequence, which is made of

the selected tabs from Seq 1 to Seq 10.
« Input range: 1 repetition to 9999 repetitions

Instruments menu Select AC + DC mode.
» You cannot execute this test in AC mode or DC mode.

QIS2
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Test overview

The unbalance immunity test tests the immunity of a device against unbalance in three-phase.

BElectromagnetic class

QIS2 is not designed for a particular class. It also does not have conditions for setting the class. Set
appropriate test conditions for your EUT.

Qls2
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IEC61000-4-27

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item

Description

Seq tab

You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Reference

Select the phase that will be used as the reference for setting Ua, Ub, Uc,
and Phase angles. Select Reference first because it will affect the Ua, Ub,
Uc, and Phase angle settings.

Ua[%]

Ub[%)]

Uc[%)]

Enter a ratio of a quantity to the rated voltage of the EUT. The positions
where Ua, Ub, and Uc are displayed vary depending on Reference setting.
+ Inputrange: 0.0 % to 150.0 %

Phase angle ab/bc/ca
[

Enter the phase angle. The suffixes (phase pairs) that are displayed vary
depending on Reference setting.

ab: Ua-Ub phase angle

bc: Ub-Uc phase angle

ca: Uc-Ua phase angle

+ Inputrange: 0° to 359°

Phase angle ac /ba/cb
[

Enter the phase angle. The suffixes (phase pairs) that are displayed vary
depending on Reference setting.

ac: Ua-Uc phase angle

ba: Ub-Ua phase angle

cb: Uc-Ub phase angle

« Input range: 0° to 359°

Duration [s]

Enter the duration.
« Inputrange: 1.000 s to 360000.000 s

Interval [s]

Enter the repetition interval of unbalance. In this period, each phase volt-
age is set to 100 %, the ab phase angle is set to 120°, and the ac phase
angle is set to 240°.

« Input range: 0.000 s to 360000.000 s

Repeat

Enter the number of repetitions of the Seq tab.
« Input range: 1 repetition to 999 repetitions

Seq check boxes
(Seq 1 to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you
want to execute. The tests are executed in order starting from Seq 1. Any
Seq tabs that you do not select will be skipped.

Output Off

Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

UN [V]

Enter the rated voltage of the EUT.

« Inputrange: 50.0 Vto 305.0V

+ You have to select an appropriate voltage range. Use the toolbar or the
Instruments menu to set the voltage range.

Freq [Hz]

Enter the rated frequency of the EUT.
 Input range: 45.00 Hz to 65.00 Hz

Repeat all

Enter the number of repetitions of the entire sequence, which is made of
the selected tabs from Seq 1 to Seq 10.
 Input range: 1 repetition to 9999 repetitions

QIS2
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Test overview

The variation of power frequency immunity test tests the immunity of a device against variations of
power frequencies.

HElectromagnetic class

QIS2 is not designed for a particular class. It also does not have conditions for setting the class. Set
appropriate test conditions for your EUT.

BThree-phase operation

The test conditions are all set in relation to U-phase. Test signals change simultaneously in three-
phases on the basis of U-phase.

Qls2
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Variation of power frequency

QIS2

Select or enter values that are within the selectable ranges for the values shown on the screen. If

you enter a value, press Enter to confirm it.

Item

Description

Seq tab

You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Frequency 1 (f1) [Hz]

Enter the power supply frequency of the EUT.
+ Input range: 45.00 Hz to 65.00 Hz

Frequency 1 (f1)
duration [s]

Enter the duration of frequency 1 (f1).
+ Input range: 0.001 s to 360000.000 s

Transition time 1 (tp1) [s]

Enter the transition time.
+ Inputrange: 0.001 s to 360000.000 s

f1 + delta f [%]

Enter the frequency variation ratio.
+ Input range:-50.0 % to 50.0 %

Duration of f1 + delta f [s]

The same as the description given under “Frequency 1 (f1) duration [s].”

Transition time 2 (tp2) [s]

Enter the transition time (the recovery time). The input range is the
same as the description given under “Transition time 1 (tp1) [s]”

Frequency 2 (f2) [Hz]

"

The same as the description given under “Frequency 1 (f1) [Hz]

Frequency 2 (f2)
duration [s]

The same as the description given under “Frequency 1 (f1) duration [s]

Repeat Enter the number of repetitions of the Seq tab.
+ Input range: 1 repetition to 999 repetitions
Trigger Select the trigger signal output. Red marks (<) are displayed at the

positions that you select with the check boxes. They are also displayed
on the waveform preview. The trigger signal is output at the specified
time, regardless of the phase angle.

Seq check boxes
(Seq 1to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you
want to execute. The tests are executed in order starting from Seq 1.
Any Seq tabs that you do not select will be skipped.

Output Off

Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)

UT [V]

Enter the rated voltage of the EUT.

+ Inputrange: 50.0 Vto 305.0V

+ You have to select an appropriate voltage range. Use the toolbar or
the Instruments menu to set the voltage range.

Repeat all

Enter the number of repetitions of the entire sequence, which is made
of the selected tabs from Seq 1 to Seq 10.
+ Input range: 1 repetition to 9999 repetitions
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Test overview

The DC voltage dips, short interruptions, and voltage variation immunity tests test the immunity of
a device against sudden and gradual DC voltage drops.

You cannot select this test in three-phase operation.

DC voltage dips and short interruptions

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item

Description

Seq tab

You can set the test conditions on the Seq tabs (Seq 1 to Seq 10).

Test item

Select DC voltage dips or DC short interruptions.

UT [V]

Enter the initial voltage (the recovery voltage is the same value).

« Inputrange:50.0Vto431.0V

+ You have to select an appropriate voltage range. Use the toolbar or the
Instruments menu to set the voltage range.

+ Check the Seq tabs’ UT settings that will be used when the test is exe-
cuted. If the UT settings are different on different Seq tabs, unintended
voltage variations will occur depending on the Seq tabs that have been
selected for execution.

Level [%]

For the DC voltage dips test, enter the level that the voltage will be
reduced to as a percentage of UT. For the DC short interruptions test, this
is fixed to 0 % (you cannot enter the value).

« Input range: 0.0 % to 200.0 %

Impedance

For the DC short interruptions test, enter the impedance condition.

+ Input value: Select High (high impedance) or Low (low impedance).

- If you select High, the reverse current from the EUT will be blocked. If
you select Low, the in-rush current from the EUT will be absorbed.

Duration [s]

Enter the DC voltage dip or DC short interruption duration.
« Input range: 0.001 s to 360000.000 s

Interval [s]

Enter the interval between the time when the voltage returns to the
recovery voltage (UT) and the time when the next voltage drop will occur.
The last interval is the transition time to the next Seq tab.

« Input range: 0.001 s to 360000.000 s

Repeat

Enter the number of repetitions of the Seq tab.
« Input range: 1 repetition to 999 repetitions

Trigger

Select the trigger signal output. Red marks () are displayed at the posi-
tions that you select with the check boxes. They are also displayed on the
waveform preview.

Seq check boxes
(Seq 1 to Seq 10)

Select the check boxes that correspond to the Seq tabs whose tests you
want to execute. The tests are executed in order starting from Seq 1. Any
Seq tabs that you do not select will be skipped.

Output Off Select this check box to turn off the test signal when tests are finished.
(This turns off the PCR-LE output.)
Repeat all Enter the number of repetitions of the entire sequence, which is made of

the selected tabs from Seq 1 to Seq 10.
 Inputrange: 1 repetition to 9999 repetitions
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DC power supply Voltage variations

QIS2

Select or enter values that are within the selectable ranges for the values shown on the screen. If
you enter a value, press Enter to confirm it.

Item Description

Seq tab The same as the description given under “DC voltage dips and short inter-
ruptions.”

Test item Select DC voltage variations.

UT [V] The same as the description given under “DC voltage dips and short inter-
ruptions.”

Level [%] Enter the level that the voltage will be changed to as a percentage of UT.

« Input range: 0.0 % to 200.0 %

Decreasing [s]

Enter the time for decreasing the initial voltage (UT) to the low voltage.
« Inputrange: 0.001 s to 360000.000 s

Reduced [s]

Enter the duration of the low voltage.
« Input range: 0.001 s to 360000.000 s

Increasing [s]

Enter the time for recovering the voltage from the low voltage to a value
that is the same as the initial voltage (UT).
« Input range: 0.001 s to 360000.000 s

Interval [s]

Repeat

Trigger

Seq check boxes
(Seq 1to Seq 10)

Output Off

Freq [Hz]

Repeat all

The same as the description given under “DC voltage dips and short inter-
ruptions.”
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Test overview

The voltage dips, short interruptions, and voltage variation immunity tests test the immunity of a
device against sudden and gradual power supply voltage drops.

This standard is divided into two standards depending on the input current per phase. IEC61000-4-
11 is the standard for currents of 16 A or less. [EC61000-4-34 is the standard for currents that exceed
16 A. QIS2 does not differentiate test conditions according to the input current per phase. One test
result file is created for each standard.

NOTE To protect the DIP Simulator elements, you cannot use the DIP Simulator during IEC61000-4-34
tests.
p. 24 For details on the setup items of the voltage dips, short interruptions, and voltage variation immu-

nity tests, see the corresponding items under [EC61000-4-11.
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Configuring the Interface

You can configure the interface to the PCR-LE and DIP Simulator using the I/0 configuration dialog
box. On the Instruments menu, click I/0 configuration.

VISA Resource name
PCR-LE ASRL5::INSTR -
DSI series USBO::0x0B3E::0x100E::Z7000111::0::INSTR -
Use DSI series [F] Simulation
or ITO1-PCR-L
©) ITO1-PCR-L

HVISA Resource name

Select an ID from the list, and click OK.

For RS232, USB, GPIB and LAN the string “ASRL’, “USB’, “GPIB” or “TCPIP” is displayed together
with the retrieved strings.

Example: USBO::0x0B3E::0x1015::12345678::INSTR

«  The number after "GPIB" is the GPIB address.
-« To use RS232 control, set the RS232 protocol on the AC power supply as follows.
Baudrate: 19200 bps, Data: 8bits, Stop: 1 bit, Flow Ctrl: OFF

NOTE If you are using the LAN interface with KI-VISA, the PCR-LE ID string may not be displayed in the list.

e In this situation, on the taskbar, click All Programs, Kikusui 10 Software, KI-VISA, and then Instru-
ment Explorer to start the Instrument Explorer. Then, click KI-VISA 10 Config, select the LAN tab, and
then click Search Instruments.

BTo use the DIP Simulator

Select DSl series or IT0O1-PCR-L depending on the DIP simulator you want to use.

ESimulation

If you select the Simulation check box, you can simulate the operation of QIS2 without connecting
it to a PCR-LE. You can select single-phase two-wire (1P2W), single-phase three-wire (1P3W) or
three-phase (3P). In this manner, QIS2 can be used for demonstration.
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Display Text Size

If the display’s text size is set to a value greater than the Windows default value, the text in the QIS2
window may not fit properly, as shown in the figure below.

If this happens, set the text size to its default value.

Default value

«  Windows 7/8: Smaller - 100% (default)
« Windows XP: Normal size (96 DPI)

mf: Untitled.xml - Quick Immunity Sequencer 2

== 5 |

File Edit Instruments Option Help
& d © = @ [ & 4
Open Save Cond. Run Stop | Output | Range Zoomin Zoom out |Abort

-

i

OUTMODE| [ RANGE | [OUTRUT
oe | [5%

|

|

|

ggeué -SEq1|-Seq2|-Seq3| Seq4|-SBq5|-Seq6|-SBM
ea
] Sed 3 , - Lps
/V\A/ ’?‘ Cea 4 ? Vo\tag-e dips - ) 0.5 « cyde L Interval J
61000-4-13 % g:g g '.:-‘ Short interruption |_ 10.0 ms 100 - s |_
N Ve i
[¥] Sea 7 Phase Select
Jl]qjmﬂ",l E S:g 8 @ Phase voltage UT (Phase) ‘I[LEVE| (Phase)
V| Sea9 Al Seg () Line voltage 100.C + Vrms 70.0 + %
61000-4-14 - . .
oo | oS P
= r of
Output v
- Repeat 3 - —
61000-4-17 EE———
= = Freq [He] [50.00 =] Trigger fait phase-angle —(()Ihangeva;legée
=T
K Repeatall 3 -
61000-4-27 < | i |
f\ﬂm
oo I
7‘|F7 <« [
v R Ph Level |Angle inc, Reduced |l i I
epeat . ase evel |Angle Decreasing Reduced |[Increasing| In
61000-4-29 e o | TeSET || gy | UU v [%] |[deg] [s] (cy:cycle) [s]
e —
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Changing the Display Text Size

Windows 7/8

1

Right-click the desktop, and click Personalize.

Display Text Size

2 Click Display, which is located in the lower left of the Personalization window.

3 Click Smaller - 100% (default).

@Qvl_ + Control Panel » Appearance and Personalization » Display

%\

Control Panel Home

Make it easier to read what's on your screen

Adjust resolution

You can change the size of text and other items on your screen by choosing one of these options. To

temporarily enlarge just part of the screen, use the Maanifier tool.

Adjust brightness

Calibrate color

@ Smaller - 100% (default)

Change display settings
Connect to a projector
Adjust ClearType text
Set custom text size (DPI)

See also
Personalization

Devices and Printers

@ Medium - 125%

Preview

Apply

Windows XP

1
2
3

Right-click the desktop, and then click Properties.

In the Properties window, click the Settings tab and then Advanced.

From the DPI setting list, choose Normal size (96 DPI).

(Default Monitor) and VM Additions 53 Trio32/64 P

General | adapter | Monitor | Troubleshoot

Display

IF your screen resolution makes screen ikems koo small to view
comfortably, you can increase the DPI to compensate. To change
font sizes only, click Cancel and o to the Appearance tab.

DPI setting:
Mormal size (96 DPT) v
Hormal DRI}
Large size (120 DPT)

Custom setting. ..
Compatibilty

Some programs might not operate properly unless you restart the
computer aftsr changing display settings.

After I change display settings:

() Resstart the computer before applying the new display settings
() Apply the new display settings without restarting

) Ask me before applying the new display settings

Some games and other programs must be run in 256-color mods.
Learn more about running programs in 256-color mode.
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List of Error Messages

Message Cause Remedy
As an interface error has occurred at « The PCR-LE power turned off while QIS2 Check the PCR-LE power
<PCR-LE>," Quick Immunity was running. supply and communica-

Sequencer 2 is closed. Turn off the
power switch of the <PCR-LE>.!

« The communication cable disconnected
while QIS2 was running.

tion cable.

As an interface error has occurred at

<DIP simulator>,2 Quick immunity
Sequencer 2 is closed. Turn off the

power switch of the <PCR-LE>" and
<DIP simulator>2

« The DIP simulator power turned off while
QIS2 was running.

« The communication cable disconnected
while QIS2 was running.

Check the DIP simulator
power supply and com-
munication cable.

I/0 connection of <PCR-LE>" is
failed. Do you want to set up I/O
Configuration?

« The PCR-LE power was off when QIS2
started.

- The communication cable was not con-
nected when QIS2 started.

Check the PCR-LE power
supply and communica-
tion cable.

/0 connection of <DIP simulator>?
is failed. Do you want to set up 1/0
Configuration?

« The DIP simulator power was off when QIS2
started.

« The communication cable was not con-
nected when QIS2 started.

« The DIP switch on the rear panel of the DIP
simulator was not set properly when QIS2
started.

Check the DIP simulator
power supply, communi-
cation cable, and DIP
switch settings.

Signal cable error occurred at <DIP

simulator>.2 Do you close Quick
Immunity Sequencer 2?

The phase signal cable between the PCR-LE
and DIP simulator is disconnected.

Check the signal cable.

1 The PCR-LE model in use will be displayed.
2 This can only be selected when the PCR-LE output is off.
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Menu Reference

Menu Description
File

New Creates a new test conditions file with the default values and no file name
(Untitled).

Open' Selects the test conditions file that you want to open.

Save (Test Condition)' Overwrites the open test conditions file with the present test conditions. The
settings of all the standards are saved.

Save As (Test Condition) Assigns a name to the conditions file and save it in the folder that you specify.
The settings of all the standards are saved.

Test result file Options Configures the test result file format by setting the separator, character code,
and extension.

Save as (Test Result) Assigns a name to the execution result file and save it in the folder that you
specify.

Recently Test Conditions Displays the most recently used test conditions files (up to eight files) on a sub

Files menu. Click one of the displayed file names to open the file.

Exit Exits QIS2.

Edit

Copy of Seq tab Copies all the items on the selected Seq tab to memory.

Paste of Seq tab Pastes the items that you copied to memory with Copy of Seq tab in the
selected tab. This command is unavailable when no items have been copied to
memory.

Copy to Next Seq tab Performs a function that is a combination of the Copy of Seq tab and Paste of
Seq tab functions. All the items on the selected Seq tab are copied to memory
and pasted in the next tab.

Default data for Class1 Test levels 1 to 8 are displayed on a sub menu. Classes and test levels that are

Default data for Class2 not applicable are unavailable. Click the displayed test levels to set the values
of the selected standard to the default values.

Default data for Class3

Zoom in' Zooms horizontally the waveform that is displayed in the waveform preview.

Zoom Out’ Zooms horizontally out of the waveform that is displayed in the waveform pre-
view.

Instruments

Run' Starts the test.

Stop' Stops the test that is running. Note that this does not turn off the PCR-LE’s out-
put.

Abort’ Aborts the test that is being executed and turn the PCR-LE output off.

« In an emergency, turn the PCR-LE’s POWER switch off.
Output’ Turns on the PCR-LE output. Tests can be started with the output turned on.

When the output is off, click Output to turn the output on.

Voltage Range"”

2

“High” and “Low” are displayed on a sub menu. Select one of these ranges.
You can only switch between these ranges when the output is off.

Low (100 V range):

The PCR-LE voltage range is set to 100 V. A check mark appears to the left of
this value when it is selected.

High (200 V range):

The PCR-LE voltage range is set to 200 V. A check mark appears to the left of
this value when it is selected.

QIS2
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Menu Reference

Menu Description
AC mode2 Selects the PCR-LE AC mode.
DC mode? Selects the PCR-LE DC mode.
AC + DC Mode? Selects the PCR-LE AC + DC mode.
Alarm clear Clears the detected alarm.
Before you clear the alarm, remove all the causes of the alarm.
Setting Limits Sets the voltage limits, current limits and protection functions (OVP and UVP)
/0 Configuration3 Configures the settings for communicating with devices such as the PCR-LE.
This displays the I/0 Configuration dialog box.
Options
Factory default Clears the history of the combo boxes and reset them to their default values.
Color Changes the preview waveform color, background color, wave progress bar
color and line width.
Display Options Sets whether confirmation messages and waveform progress will be dis-
played.
Help
Contents (J) Displays the Japanese QIS2 operation guide.
Contents (E) Displays the English QIS2 operation guide.
User’s manual (J) Displays the PDF of the Japanese QIS2 operation guide.
User’s manual (E) Displays the PDF of the English QIS2 operation guide.
About Quick Immunity Displays the QIS2 version information.
Sequencer 2
1 A button that performs the same function is available on the toolbar.
2 This can only be selected when the PCR-LE output is off.
3 When Use DSl series or ITO1-PCR-L is selected, you cannot perform the IEC61000-4-11 voltage variation test. In this situa-

tion, you can only select the voltage dips and short interruptions options.
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